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SimpleIndex lets you create searchable PDF documents from scanned images using OCR to convert the pages to text and overlay it on the original scan. This creates a unique scanned document that’s fully searchable and lets you highlight and copy text, while preserving the original page formatting for readability.
Unlike other basic OCR applications, SimpleIndex also lets you automatically tag and organize documents using keywords identified with pattern matching, database lookups or bar codes. Structured data can be used to populate a database, document management system, SharePoint and other repositories.





       

Take control of Sales Tax exemption forms
 Monday, 14 November 2022 by Simple Software

Automatically fill and file sales tax forms
Ben Franklin once noted, “…nothing is certain except death and taxes.” In the case of state sales taxes, they may be unavoidable, but managing your customers’ sales tax exemption forms and making sure you’ve sent current exemption certificates to your vendors doesn’t have to feel like a terminal condition.

SimpleIndex has the power to recognize the forms you receive from customers and file them automatically so you can find them in seconds.
SimpleIndex also fills out sales tax exemption PDFs from every state to create a complete set of your forms ready for emailing to your vendors.
Link both processes to your customer and vendor data sources to streamline the process. Even without those lists, the state, certificate number and expiration recognize automatically, leaving you with the simple task of clicking on the customer name to file the document away.




Comes with automatically fillable PDF Sales Tax Exemption Forms from Every State
You’ll never have to dig through old emails or piles of paper to make sure you have that exemption on file again!
When it’s time to send your vendors the proper state certificate to get your sales tax exemption, simply open up the Fill Vendor Form job, select the vendor, and all your state exemptions are filled out automatically and assembled into one PDF file suitable for framing emailing.
Manage your customer sales tax exemption forms:
	Scan customer sales tax exemption certificates submitted on paper
	Process e-mailed PDF sales tax exemption forms
	Use OCR or read the filled-in forms from PDF files to file them automatically
	Search and view customer tax forms in seconds
	Receive automatic e-mail notifications when exemptions expire

       

Index Tax Exemption Certificates with SimpleIndexFill out and e-mail vendor sales tax exemption forms:
	Standardized, fillable PDF sales tax forms for every state
	Select a vendor and fill in all the relevant name and address information automatically
	One click fills in every state form with both your company’s information and your vendor’s
	Packages saved to bookmarked PDF files and e-mailed to vendors
	Receive automatic e-mail notifications when exemptions expire

       

Filling out all state certificates with a single entry to send to vendorFind out more!
The sales tax management solution is available for free to SimpleIndex users!
Download SimpleIndex – Download the Sales Tax Jobs
Some initial setup is required, and we can help you out with that too. Our Professional Services department can have you up and running in just a couple of hours.
Please Contact Us to find out more about automating your sales tax time thieves with SimpleIndex!
Learn More:
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Indexing Solutions with Barcode Recognition
 Monday, 14 November 2022 by Simple Software





Barcode recognition is the most efficient way to capture index data printed on documents. If you are unfamiliar with the use of barcodes in document scanning, you can learn more about barcodes in our Barcode Scanning Guide, but if you want to know more about barcode use with SimpleSoftware products, read on.
Some documents already have key information in barcode format on them. In many cases adding a barcode to a document is as simple as changing or adding a font. Adding barcodes to new documents is preferable as all the index data is on the document at the time it is created and in a format that can be read with near 100% accuracy.
As an alternative to placing barcodes on the individual documents, it is possible to print out a barcode cover page and place it on the file before it is scanned. The SimpleCoversheet application was designed to make this easy by providing a simple interface for selecting index values and printing a standard coversheet that contains these values in barcode format.
Barcode recognition can also be useful when you have documents with a variable number of pages that will all receive the same index values. If it is not possible to generate an indexed coversheet for these at the time they are created, a generic barcode coversheet can be used to separate the scanned images into multi-page files, one for each document. A second process can then be used to index these images one file at a time instead of one page at a time, greatly increasing throughput.
Barcode Recognition Features

 Your browser does not support the video tag.With SimpleIndex Barcode you can:
	Read barcodes printed on scanned paper documents
	Read barcodes embedded in PDF files
	Automatically rename files based on barcodes
	Export barcode data to CSV file or any database
	Separate multi-page documents with cover pages
	Recognize 2D formats like PDF417, DataMatrix, Aztec and QR Code
	Recognize 30 different 1D barcode formatsCode 39, Codabar, UPC, Code 128, EAN 13, 2 of 5, etc.
	Recognize postal barcodes like Planet, PostNet, Royal Post and Australian Post
	Lookup barcode values in a database for additional data
	Complete list of document scanning & indexing features

With SimpleCoversheet you can:
	Create barcode coversheets for use with SimpleIndex and other scanning applications
	Print barcodes on Avery label templates that can be applied to documents
	Affordably enable every employee to print barcodes
	Create coversheets that allow SimpleIndex to automatically index and file documents
	Enable scanning and indexing from MFPs, network scanners and digital copiers
	Perform “mail merge” with barcodes to print many coversheets at once
	Supports many 1D and 2D barcode formats

       

Learn More:




































KB Articles for Barcode Recognition
	Turn On Replacement Characters for Barcodes
	Regular Expression (RegEx) - Syntax or Type
	Autonumber Increment Value
	What are some other terms for Bar Code Scanning Software?
	Can SimpleIndex read bar codes from existing PDF files?
	I cannot recognize PDF417 or QR Code bar codes. What does "Advanced "Only" mean?
	Can I split TIFF or PDF files based on barcodes as a separator and also name the file with the barcode value?
	Will SimpleIndex read multiple barcodes on a page and save the value to the appropriate index field?
	Is there a way to just use part of a bar code or OCR value? For example, extract "50" from the value "124450"
	How can I delete the barcode or blank page cover/separator sheet that I don't need to save?
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Automated Processing & 1-Click Interface
 Monday, 14 November 2022 by Simple Software







SimpleIndex® 1-click scanning and indexing is enabled with its command line interface. SimpleIndex job files can be saved and opened just like a Word document. When you open a job file, SimpleIndex begins processing a new batch automatically. Scanning, processing (OCR, barcodes, database autofill, etc) and export happen in sequence with no further input from the user.
For unattended processing, the command line interface lets you use Windows services and scheduled tasks to automate OCR,  barcode recognition and database export tasks.
The Command Line Interface also allows SimpleIndex to be integrated with custom software applications with minimal to no programming required.
	Field values, processing folders and other settings can be passed as command line parameters
	Any SimpleIndex option can be set using XML job files
	Database export links processed files to your app automatically
	Control application behavior (display window, exit after processing, etc.)
	Pre-Process and Post-Process features can execute other command line applications at start and end of batch



Unattended Server-Based Processing





SimpleIndex lets you run any SimpleIndex job as a Windows service for fully unattended processing. This is particularly useful for high-volume, high-demand applications where scanned images are coming from many remote workstations, as well as small and large implementations utilizing network scanners or digital copiers. In server mode, images are saved to a “hot folder” on the server where they are processed automatically. SimpleIndex performs barcode recognition, ocr and other indexing tasks and exports formatted files to storage and database servers.
Server processing licenses may be added to any version of SimpleIndex. Unattended processing is possible without a server license, but a user must be logged on to the workstation for it to execute. Windows services run automatically when the computer is booted up, even if nobody is logged on. You must have a Server license to run SimpleIndex on Windows Server operating systems.
SimpleIndex Servers can run multiple jobs on different schedules on the same server, or run multiple instances of the same job simultaneously to take advantage of multiple CPUs.
Integrate SimpleIndex in your Custom Application





Are you a developer looking for an easy scanning interface to use with your custom database application? Then SimpleIndex is the perfect solution for you!
With SimpleIndex, you can easily package pre-configured scanning and indexing settings for distribution with your application. SimpleIndex‘s command-line interface allows you to pre-set some or all of the index values for each batch, or even to hide the SimpleIndex GUI altogether. SimpleIndex can also interface directly with your database, inserting or updating index values and associating them with the images you scan. With SimpleIndex, you won’t have to write a separate import routine to get the new information into your database.
SimpleIndex is a far better option to developing your own scanning interface from scratch. If your application needs to use advanced features like barcode recognition or dynamic OCR, SimpleIndex saves you hundreds of hours of development time. If you need to let users preview each image, rotate, clean-up, rescan or index as necessary, why reinvent the wheel?
SimpleIndex means it is no longer too costly or complicated to bundle a full scanning application with your custom software. Being a SimpleIndex reseller means big discounts on every copy you sell. Sign up now!
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Command Line Arguments
 Wednesday, 07 April 2021 by Alex Stewart

Please refer to the Wiki Documentation for the complete Command Line Interface reference.
In addition to running a particular SimpleIndex Job Configuration with a command line script, other features might be required.  This could be stopping dialogs from turning on, suppressing dialog boxes or passing the input or output folder to the Job.  Below you will find some of the commands that can be added to the standard command line that SimpleIndex uses.
Start with the traditional full command line to run SimpleIndex, which you can find here:

“C:\Program Files (x86)\SimpleIndex\SimpleIndex.exe” /c:”<Path to Job>”
In this example /c: is the command to direct what Job Configuration is used, but I have listed more below.  Each new argument should be separated by a space.
	/q = Prevents certain dialog boxes from appearing that require a manual click.
	/s = Prevents other dialog boxes from appearing that require a manual click.
	/i: = Set the specific Input Folder you would like to import files from.
EX. “C:\Program Files (x86)\SimpleIndex\SimpleIndex.exe” /c:”<C:\Images\Scan Files.sic>” /i:”C:\Images\Input”
	/o: = Set the specific Output Folder you would like to import files from.
EX. “C:\Program Files (x86)\SimpleIndex\SimpleIndex.exe” /c:”<C:\Images\Scan Files.sic>” /i:”C:\Images\Output”
	/d:15 = Set Processing Log to highest level and turn on log output.  This will turn on the Processing Log, without having to do it manually.
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Set Job Timeout on Server Processing Job Configurations
 Tuesday, 08 December 2020 by Alex Stewart

Please refer to the Wiki Documentation for the complete Unattended Processing reference.
Certain Job Configurations when running as a service will stop in the middle of processing the batch.  There won’t be an error in the Windows Event Viewer or in the SimpleIndex Processing Log that indicate what the issue.  This can be fixed in many cases by setting the Job Timeout to stop the Batch after a certain number of seconds, which causes bad batches to get skipped and not to run indefinitely.
Instructions to set the Job Timeout:
	Open the Configure SimpleIndex Service.
	Select the Job Configuration that you would like to set the Job Timeout for from the list.
	Set the number of seconds that you would like to have a Batch Job end if no progress is made.  We usually recommend that this be set to 60.
	Click the Save Changes button
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Process Monitor/ProcMon Instructions
 Tuesday, 28 July 2020 by Alex Stewart

Please refer to the Wiki Documentation for the complete Processing and User Interface reference.
In some cases there will be errors with SimpleIndex or issues without errors that are too general to get the information needed to fix the issue easily.  When this happens a very detailed log is needed to determine what exact processes are occurring when the issue happens and which processes are failing.  This is done by using the Microsoft Process Monitor to log everything while running SimpleIndex.
The instructions for how to install and run the Process Monitor are below.
	Download the process monitor from Microsoft by clicking HERE and then clicking Download Process Monitor.
	Unzip the “ProcessMonitor.zip” file and save it to any location on the computer running SimpleIndex.
	Run the “Procmon.exe”
	Once the program opens go to the File Menu and uncheck “Capture Events”
	Go to the Edit menu and select “Clear Display”
	Go to the Filter Menu and select Filter
	Set the first drop down to Process Name
	Set the second drop down to Contains
	Type in “Simple” into the third field
	Click Apply then OK
	Go to the File Menu and check “Capture Events”
	Immediately run SimpleIndex with the process that is having the issue exactly as you normally would and let it run until the issue occurs.
	Once the issue occurs go back to the Process Monitor window and then to the File Menu and uncheck “Capture Events”
	Go to the File Menu and select save.
	Use all the defaults to save to a folder that you can easily access and name the file with today’s date.
	Send us this file for review.
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FastImport to Disable Automatic Processing During Import
 Thursday, 27 February 2020 by Alex Stewart

Please refer to the Wiki Documentation for the complete Fast Import Interface reference.
SimpleIndex has a variety of processing functions that automatically happen behind the scenes when importing documents to improve the quality and functionality of the images and processing capabilities of the software.
On some occasions these extra processing functions cause delays and conflicts or aren’t needed at all.  If these processing functions are causing SimpleIndex to crash or slow down the import processing too much for a particular Job Configuration that can be turned off with a registry setting.

Follow these instructions to add this registry setting:
	Close out of SimpleIndex entirely
	Open the Windows Registry by going to the Windows Search and searching for “RegEdit”
	Go to this location in the Registry Folder Tree: Computer\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\SimpleIndex\Misc
	In the right section of the Registry window Right Click in the white space and select New>String Value
	Name the new key “FastImport”
	Open the “FastImport” Registry Key, set the value to “1” and then click OK
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Command Line Sample
 Monday, 29 July 2019 by Simple Software

Please refer to the Wiki Documentation for the complete Command Line Interface reference.
When using the Simple Software products it can be beneficial to run the software from a command line script.  With this you can run other Simple Software Job configurations or Windows Batch Files (.bat) or Task Manager or other command line methods automatically.
You can find sample formats of the command lines for Simple Software products below.
SimpleIndex:
“C:\Program Files (x86)\SimpleIndex\SimpleIndex.exe” /c:”Path to job file”
SimpleSend:
“C:\Program Files (x86)\SimpleIndex\SimpleSend.exe” “Path to job file” /hide /run
SimpleQB:
“C:\Program Files (x86)\SimpleIndex\qb\SimpleQB.exe” “Path to job file” /hide /run
/hide and /run in the SimpleSend and SimpleQB examples above hide any windows from being displayed and automatically runs the process respectively.
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Regular Expression (RegEx) – Syntax or Type
 Monday, 29 July 2019 by Simple Software

Please refer to the Wiki Documentation for the complete Regular Expressions reference.
SimpleIndex uses the .NET regular expressions library.
.NET uses the JavaScript/ECMAScript regular expression syntax format.
For more information see the Regular Expressions Wiki Page.
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Check and Repair All PDF Files
 Monday, 29 July 2019 by Simple Software

Please refer to the Wiki Documentation for the complete PDF reference.
You can set SimpleIndex to assume that it needs to check every PDF file and fix it.
Go to this location in the Windows Registry:
Computer\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\SimpleIndex\Misc
Create a New String Value called “FixAllPDF” and set the value to 1
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Keep Pages in Original Order when Bookmarking
 Monday, 29 July 2019 by Simple Software

If you want to keep all the pages in the same order that they were imported, even though they all go with different bookmarks then do the following.
1.  Open the configuration in Notepad.
2.  Search for <BOOKMARK_PAGE_ORDER>
3.  Change this line from “false” to “true”:  <BOOKMARK_PAGE_ORDER>true</BOOKMARK_PAGE_ORDER>
4.  Save and close.
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Is it possible to search for and retrieve documents with Windows desktop search?
 Wednesday, 28 February 2018 by dwilder

Please refer to the Wiki Documentation for the complete Searchable PDF reference.
Windows Search works great with SimpleIndex because all index data can be saved to the folder and file names as well as the file properties, and OCR text can be saved to hidden layers in PDF files. Windows Search will read all of these elements when building its index and will return any matching files when you search.
Using Windows Search on a file server allows for instantaneous searching across terabytes of documents and text for all of the users on your network.
IFilters allow Windows Search to search within file contents.
Here are three popular PDF IFilters that will enable text searching for PDF files:
	Foxit PDF IFilter (commercial)
	TET PDF IFilter (free/commercial)
	Adobe PDF IFilter (32-bit / 64-bit) (free)

If you have issues with PDF text searching in Windows 10, this article has detailed instructions for resolving PDF IFilter issues:
https://fixedit.itxpress.biz/2018/07/05/searching-pdfs-in-windows-10/
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How much do Simple Software products cost?
 Wednesday, 28 February 2018 by dwilder

Click here for the latest pricing and online ordering information. You can also purchase full service solutions from one of our Authorized Dealers.
Click here for a PDF version of the price list and a feature matrix that shows which features are included in each version.
All applications are activated online by entering a serial number in the demo. The serial is emailed to you once your order is processed.
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I’m using full page OCR. The information is all appearing in the txt file but it is losing format about half way through. Data to the right is ending up at the end of the txt doc. Can this be fixed?
 Wednesday, 28 February 2018 by dwilder

Please refer to the Wiki Documentation for the complete Full-Page OCR reference.
SimpleIndex version 7 solves this problem with the incorporation of the FineReader OCR engine. Full text in PDFs will now flow with the formatting of the PDF.
Legacy Versions: SimpleIndex can also be used with other OCR applications and servers to improve accuracy, formatting and performance. Use the OCR applications to convert the scanned images to text or searchable PDF, and SimpleIndex can extract index values from the text and automatically sort and organize the files.
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How do you train the OCR engine for better accuracy?
 Wednesday, 28 February 2018 by dwilder

Training has been removed with version 7 due to the addition of the ABBYY FineReader OCR engine.
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How do you configure full text searching in Retrieval mode?
 Wednesday, 28 February 2018 by dwilder

Please refer to the Wiki Documentation for the complete Database Settings reference.
On the Database tab there dropdown in the lower portion of the panel for Full Text OCR Field. Put the name of the field that will store the full-text data there. This must be configured both for Insert and Retrieval mode configurations. The database field needs to be sufficient length to store the entire text of your document.




Of course, the Insert Mode configuration must have “Enable Full Page OCR” checked to generate full text data from images. Text from MS Office documents, PDF files and existing OCR text files can be used without setting this option.
When designing your Retrieval Mode configuration, create a Text field to use for full text search queries. On the Database tab, set the corresponding “Database Field Name” to the full text database field.
When searching on your full text field, SimpleIndex finds the text you enter no matter where it appears in the document. It is able to match partial words. It does not perform boolean or natural language searches. The text entered must match the document text exactly.
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How do you configure OCR to read index information from MS Office or PDF documents?
 Wednesday, 28 February 2018 by dwilder

Please refer to the Wiki Documentation for the complete Zones & OCR Settings reference.
MS Office and PDF files generated by software or PDF printer drivers already have the text you need to recognize in the file. Scanned documents need to use OCR to read text from an image of the page. With Office and PDF files, SimpleIndex can just read the text, which is much faster and accurate than image OCR.
To recognize index fields from the document text, first create OCR fields on the Index tab as you would normally. Next, on the Zones & OCR options tab, check the “Use Full Page OCR for this Field” option for each OCR field. This tells SimpleIndex to process the existing file text.
If the index value is a unique pattern of digits or list of possible values, use Template or Dictionary matching to locate the value within the text. Please see the manual for details on Template and Dictionary matching.
If the value appears in a specific location in each file, coordinates can be used to locate it. When processing text, the X, Y, Width and Height settings correspond to line and column numbers within the file text. This is explained in greater depth in the manual.
SimpleIndex will assume that any TXT file with the same name as a file being processed is the OCR text for that file, so this method can work with any type of file.
Find out more about Optical Character Recognition on the SimpleOCR Guide.


 Microsoft Word Data ExtractionMS OfficeOffice PDF Document IndexingOffice PDF Text ProcessingOffice to PDFPaperless OfficePDFPDF Archive Scanning SoftwarePDF Barcode RecognitionPDF Data Extraction SoftwarePDF FormsText ProcessingUnattended Processing

 Read more



	  Published in OCR, Office PDF Text Processing

 No Comments



How can I improve recognition rates for my OCR fields?
 Wednesday, 28 February 2018 by dwilder

There are several things you can do to improve accuracy for OCR.
	Scan at 300dpi, black & white for best results.
	Adjust the scan settings to remove background noise and improve the definition of characters.
	For Zone OCR, field recognition can often vary based on the surrounding white space and text in the zone. Try varying the size of the zone to achieve optimal results.
	For template matching, make sure all variations of the field format are included in the template list.
	For dictionary matching, add common variations and OCR mistakes to the “thesaurus” list.
	On the Zones & OCR tab (accessed from the Job Options) you can adjust the Max Errors setting to allow for more mistakes in the dictionary matching process.
	Use the Strip Spaces, Strip Characters, Replace Characters and Case Fixing options to standardize the field format prior to matching.

Please refer to the SimpleIndex Wiki for details on how to configure these options.
Related Links
	SimpleIndex.com – Zone OCR
	SimpleIndex.com – Dynamic OCR
	SimpleOCR.com – OCR Guide
	SimpleIndex Wiki – OCR
	SimpleIndex Wiki – OCR Options
	SimpleIndex Wiki – Zone OCR
	SimpleIndex Wiki – Full Page OCR
	SimpleIndex Wiki – Zones & OCR Settings
	SimpleIndex Wiki – OCR to Field
	SimpleIndex Wiki – OCR Text View
	SimpleIndex Wiki – Template & Dictionary Matching OCR
	SimpleIndex Wiki – OMR and OCR Document Separation
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Can OCR text be saved to Office, Text, HTML or other formats?
 Wednesday, 28 February 2018 by dwilder

Yes.  On the OCR step of the Job Settings Wizard you can select the text output format need in the “Full-page OCR file type” drop down. By default it is set to PDF, but can be changed to Text (txt), Word (docx), Rich Text (rtf), Open Office (odt), Excel (xlsx), PowerPoint (pptx), ePub Zip (epub), FictionBook (fb2), HTML (htm), XML (xml) or Alto XML (alto.xml).
 





If the output file type is set to PDF, OCR text will be embedded as hidden text in the PDF file.
Related Links
	SimpleIndex.com – Zone OCR and Dynamic OCR
	SimpleIndex Wiki – Full Page OCR Formats
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Can SimpleIndex create searchable PDF Image+Text files with hidden text?
 Wednesday, 28 February 2018 by dwilder

Yes, it can.  You can configure this setting in the Job Settings Wizard by going to the OCR step and checking “Enable full-page OCR”.  There are many settings in the OCR step that you can used to customize the output and recognition of images.





SimpleIndex has two different OCR engines (Standard and Professional) that can be used to produced PDF Image + Text files or Searchable PDFs.
Related Links
	SimpleIndex.com – OCR Languages
	SimpleOCR.com – OCR Guide
	SimpleIndex Wiki – OCR
	SimpleIndex Wiki – Searchable PDF
	SimpleIndex Wiki – OCR Options
	SimpleIndex Wiki – FineReader
	SimpleIndex Wiki – MRC
	SimpleIndex Wiki – Tesseract
	SimpleIndex Wiki – Languages
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Recent KB Articles
	How to activate any Add-on or Upgrade to SimpleIndex?
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Online Support Options




 Check our Wiki Help, Knowledge Base and Training Videos, or Contact Support if you still need Help


How to Buy




Solutions start at just $500! Buy SimpleIndex online or from an Authorized Dealer in your area.


Authorized Dealers




SimpleIndex is a great addition to any system integrator's product line. Become an Authorized Dealer.



Get a Web Demo




Get a free online demo with a scanning specialist who can configure SimpleIndex on your computer remotely.
 Sign up for a demo now!


Download a Trial




30-day trial downloads are available for all Simple Software applications. 
 Download Now!


SimpleIndex Applications




 Packaged apps built with SimpleIndex.
 SimpleInvoice for AP
 Sales Tax Manager
 Mortgage LoanStacker
 MSDS and Patents
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Manage Cookie Consent
 


We use cookies to optimize our website and our service.
    Functional cookies    Functional cookies  Always active       The technical storage or access is strictly necessary for the legitimate purpose of enabling the use of a specific service explicitly requested by the subscriber or user, or for the sole purpose of carrying out the transmission of a communication over an electronic communications network.
     Preferences   Preferences       The technical storage or access is necessary for the legitimate purpose of storing preferences that are not requested by the subscriber or user.
     Statistics   Statistics       The technical storage or access that is used exclusively for statistical purposes. The technical storage or access that is used exclusively for anonymous statistical purposes. Without a subpoena, voluntary compliance on the part of your Internet Service Provider, or additional records from a third party, information stored or retrieved for this purpose alone cannot usually be used to identify you.
     Marketing   Marketing       The technical storage or access is required to create user profiles to send advertising, or to track the user on a website or across several websites for similar marketing purposes.
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